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What's in here.
A quick run-through of the document, the layers, and the

colour and image rules that keep your file press-ready. Skim

the checklist on page 14 if you're in a hurry.
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A NOTE  These rules aren't picky for the sake of it. Every one of them came from a real job that

nearly went sideways on press. Follow them and your run goes smoothly — skip them and we'll

send you a friendly email asking for changes before we print.
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01 BEFORE YOU START

A short read.
Saves you a re-press.
We wrote this so your file lands on

our press exactly the way you drew

it on screen — no surprises, no slow

rounds of email, no awkward

conversations about why the gold

looks grey.

Everything in this guide is the result of years

of running other brewers' artwork. Most files

we receive are 90% there. The last 10% — the

bleed, the colour mode, the embedded

images, the outlined fonts — is what this

document covers.

If you're a designer who does this every day,

the checklist on page 14 is for you. If this is

your first run, read the whole thing. It's twelve

pages of plain talk and one diagram per topic.

What you'll need

SOFTWARE Adobe Illustrator (preferred),

InDesign, or any vector tool that

exports PDF/X-compatible files

OUTPUT One PDF, all layers intact, all fonts

outlined

COLOUR CMYK or Pantone C — no RGB

TIME 20 minutes to read · 10 minutes to

check your file

STUCK?  Send the file anyway. We'll

open it, see what's missing, and tell you.

Most issues take five minutes to fix once

you know what they are.

THE 30-SECOND VERSION

3 mm bleed, 1.5 mm safety

One PDF, five named layers

CMYK only · K100 (not rich black)

Images embedded at 300 dpi

Fonts outlined

Min. type 8 pt · min. line 0.5 pt

Export as PDF 1.4

TALK TO A HUMAN

If anything in here doesn't make sense, get in

touch. We answer our own emails.

hello@brimlabel.com

Live chat · brimlabel.com

brimlabel 01 · BEFORE YOU START
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02 TEMPLATES · BLEED · SAFETY

Start with the right geometry.
Every label artwork carries three boundaries — bleed, trim,

safety. Get these right and the rest of the file falls into place.

The three boundaries

BLEED 3 mm beyond the cut line — fills the

gap left by die-cut tolerance

TRIM The actual cut line of the label

SAFETY 1.5 mm inside the trim — keep all text

and important graphics within this

Background art and colour fills should run all

the way to the bleed edge. Anything you can't

afford to lose — type, logos, barcodes — stays

inside the safety line.

Why 3 mm? Die-cutting is mechanical.

The blade and the print don't land on

exactly the same fraction of a millimetre

every time. The bleed absorbs that

movement; without it you get a hairline of

unprinted paper at the edge.

Building the template

Create your document at the final label size,

then add the bleed in your document setup

(Illustrator: File > Document Setup > Bleed).

Draw the cutting line as a separate path on

the Diecut layer — see the next page.

FIG. 02 —

Bleed, trim,

safety

Bleed (hatched) ·

trim (solid) · safety

(dashed)

HEADS UP  Don't make the bleed wider

than 3 mm. More isn't safer — it just

means your design gets cropped further

when we trim.

brimlabel 02 · TEMPLATES, BLEED & SAFETY

Tributary

West Coast IPA

330 ML · 6.4% ABV

3 mm BLEED

TRIM

1.5 mm SAFETY
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03 LAYERS · LAYER ORDER

Five layers, in this order.
Every file we press uses the same layer structure. Same names,

same order, every time. It tells our pre-press exactly what to

print, cut, foil, and varnish.

The layer stack (top → bottom)

Naming matters

Spell the layer names exactly: Diecut ·

Varnish · Foil · White · Artwork.

Our pre-press scripts pick them up by name. A

layer called "cut line" or "die" gets missed.

Order matters

Diecut sits at the top so it's visible on every

check. Artwork is at the bottom — it's the

deepest layer of the print, the foundation

everything else sits on.

IF YOU DON'T NEED IT, DELETE IT  Don't ship empty Varnish or Foil layers "just in case". An

empty layer is a question we'll have to ask you. Only include the layers your label actually uses.

brimlabel 03 · LAYERS & LAYER ORDER

01
Diecut

A single closed path — the cut line of the label. Nothing else lives here.
Required

02
Varnish

Filled shapes marking where 3D spot varnish should land.
Optional

03
Foil

Filled shapes marking elements for hot foil or 3D foil.
Optional

04
White

The white plate — needed for transparent or metallic labels (see pages 06–08).
Conditional

05
Artwork

All your design lives here — type, illustration, images, backgrounds.
Required
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04 CREATING THE WHITE PLATE

A spot colour
called HPI-White.
If your label is transparent, metallic, or sitting on anything

other than plain white paper, we need a white plate. Create it as

a spot colour, name it exactly, and we'll know what to do with it.

Set it up

In your swatches panel, create a new colour

swatch and use these settings:

NAME HPI-White

TYPE Spot colour

VALUES C30 · M0 · Y0 · K0

MODE CMYK

Spelling counts. HPI-White — capital

H, capital P, capital I, hyphen, capital W.

The dash is real. Our pre-press scripts

look for that exact string.

Why a cyan tint?

The C30 colour you draw with isn't what

prints — we replace it with white ink on press.

The 30% cyan is just a visible placeholder so

you can see your white plate while you're

working. Pick anything you like for the on-

screen colour as long as it's labelled HPI-

White; we'll handle the rest.

SWATCHES

HPI-

White

Spot · C30 M0 Y0

K0

[Black] Process

Brim Lime Process

On screen

C30 M0 Y0 K0

On press

White ink

FIG. 04 — HPI-

White spot swatch

Setup in the

Swatches panel

ONCE IS ENOUGH  Create the swatch

once, then reuse it everywhere on your

White layer. Don't make a new swatch

per element — you'll end up with twenty

near-identical entries and we'll have to

ask which one is the real one.

brimlabel 04 · THE WHITE PLATE
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05 TRANSPARENT ELEMENTS

Only what you want to
see gets a white plate.
On a clear label, the substrate is see-through. Anything you

want to read clearly — type, barcode, logo — needs an opaque

white layer printed underneath it. Anything you leave off the

white plate stays transparent.

Only relevant if your label stock is clear. If you're printing on standard white paper or film, skip

this page.

How to build it

1. Select every element on your Artwork layer that you want to be opaque.

2. Copy it (⌘C) and paste in place onto the White layer (⌘⇧V).

3. Select all the pasted shapes and change their fill to HPI-White.

4. Need extra opacity behind a barcode? Draw a rectangle on the White layer and fill it with

HPI-White.

ARTWORK LAYER

+

Tributary
WEST COAST IPA

330 ML · 6.4%

WHITE LAYER (HPI-WHITE)

=

TributaryTributary
WEST COAST IPA

330 ML · 6.4%

FINAL ON BOTTLE

FIG. 05 — Building a

transparent label

Artwork + matching white plate = readable design on a

clear substrate

CUT, DON'T COPY  For text or fine graphics, paste in place and keep the original on the Artwork

layer. The two layers together give you opaque colour over a solid white — that's what makes the

design legible.

brimlabel 05 · TRANSPARENT ELEMENTS

Tributary
WEST COAST IPA

330 ML · 6.4%
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06 METALLIC ELEMENTS

A silver base,
controlled by white.
Metallic labels start life as solid silver. Wherever you don't want

silver showing through, you cover it with the white plate. Less

white = more shine.

Only applies to metallic label stocks. If your job is on white or clear paper, skip ahead to colours

on page 10.

The process

Decide which parts of your design should

keep that metallic glow. For everything else:

1. Select those elements on the Artwork

layer.

2. Cut them (not copy — ⌘X).

3. Paste in place on the White layer (⌘⇧V).

4. Keep their existing colour. The white

plate underneath does the work.

That's it. The base silver shows through

wherever the white plate isn't.

How the maths works

Light colours on the White layer let only a

little silver through — you get a soft sheen.

Darker colours block more, so the metallic

effect fades. Pure black on the White layer =

no shine at all.

100% K 50% K 10% K

← LESS SHINE · MORE SHINE →

Silver effect

White on White

Gold effect

C0 M20 Y60 K0

FIG. 06 —

Metallic

value chart

White-layer colour

controls the final

metallic finish

brimlabel 06 · METALLIC ELEMENTS
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06.1 THREE TIPS BEFORE YOU PRESS

Working with metallics.
A few rules of thumb we've picked up from running thousands

of metallic jobs.

LIGHTER = SHINIER

The lighter your white-layer

colour, the more silver shows

through. Pure white reveals

the most metal.

FOR SILVER, USE WHITE

White elements on the White

layer let the substrate's silver

come through cleanly — that's

a silver-foil look without the

foil.

FOR GOLD, TRY C0 M20

Y60 K0

That mix is our house gold.

Other yellows work too — it

comes down to taste and

what's around it.

Black is special

If you want an area with no metallic effect at

all — say, a chunk of solid black type or a

dense background — set its White-layer copy

to 100% K. That blocks the silver completely

and gives you a flat, matte black on the final

print.

For everything in between, experiment: a 40%

K patch produces a moody, slightly metallic

charcoal; a 15% K patch retains a clear

shimmer. There's no exact recipe — proof a

sample if you're not sure.

PROOF IT  Metallics are the one finish

where on-screen previews lie the most. If

the job matters, ask us for a printed proof

on the actual metallic stock before we run

the full quantity. It's the cheapest

insurance you can buy.

brimlabel 06 · METALLIC ELEMENTS / TIPS

TIP 01

silversilver

TIP 02

gold

TIP 03
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07 COLOURS

CMYK only. No RGB.
Our press prints CMYK. That means every colour in your file —

fills, strokes, swatches, image profiles — needs to live in CMYK

before you export. RGB files get converted automatically and

the shift is rarely flattering.

Set the document mode

In Illustrator: File > Document Color Mode >

CMYK Color. Do this before you start designing

if you can — converting at the end can shift

saturated colours noticeably.

About Pantone

We accept Pantone swatches — but only from

the Pantone Solid Coated (C) book. Anything

else gets converted automatically using the C

palette. If consistency between runs matters

to you, convert your Pantones to CMYK

yourself so you know what to expect.

100% black is not rich black

Submit solid black as K100 only — C0 M0 Y0

K100. Don't build "rich black" (a mix of C/M/Y

under the K) for text and fine elements. It

registers poorly, looks fuzzy, and slows drying.

Save rich black for large solid areas if you

genuinely need extra depth — and ask us first.

RGB · NOT

GOOD

Saturated screen

colours. Shift on

press.

CMYK · GOOD

Press-accurate.

Reproducible run to

run.

K100 · USE

THIS

Aa Bb

C0 M0 Y0 K100 —

sharp on press.

RICH BLACK ·

AVOID

C40 M30 Y30

K100 — fuzzy

edges.

QUICK CHECK  Open the Swatches panel and look at the colour space icon next to each swatch.

Anything not marked CMYK or Spot needs converting before export.

brimlabel 07 · COLOURS
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08 IMAGES

300 dpi. Embedded. CMYK.
Any pixel-based image in your file — a photo, a scanned hop

illustration, a watercolour wash — needs to land on press at

300 dots per inch. Lower than that and you'll see it. Higher

than that and you're just inflating the file.

Resolution

OK 300 dpi at final print size

OK 600 dpi for line art (1-bit B&W)

NO Anything under 250 dpi

POINTLESS Over 400 dpi (no benefit, big

file)

Remember "at final print size". A 300 dpi

photo scaled up 200% on the label is

effectively 150 dpi. Check resolution after

you've placed and scaled the image.

Always embed

Linked images outside the file get lost in

transit and we can't print what we don't

have. Embed every image before exporting

— Illustrator's Links panel shows a chain

icon when a file is linked, a square inside a

square when it's embedded.

The Links panel also flags missing or

modified files. If you see a yellow triangle,

fix it before you send.

Convert images to CMYK

Same rule as the rest of the file — images

need to be CMYK, not RGB. Convert in

Photoshop (Image > Mode > CMYK Color)

before placing.

LINKS

hop_illustration.psd EMBED

label_bg.tif LINK

? grain.tif MISSING

↓ press Embed for each link

FIG. 08 —

Illustrator

Links panel

Embed everything ·

resolve missing

files

BITMAP TEST  Zoom to 400% on your

placed image. If you can see the pixels at

that zoom, the press will see them too.

brimlabel 08 · IMAGES
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09 FONTS & LINES

Big enough to read.
Heavy enough to see.
Labels are small, and the press has its limits. Two minimums

keep type readable and lines visible from the first print to

the last.

Minimum type

8
pt

absolute floor for readable type

on press

Minimum line weight

0.5
pt

0.18 mm — thinner strokes

drop out

Anything thinner than 0.5 pt risks dropping

out on press or going inconsistent across the

run. Reversed-out type (white on dark) needs

even more — bump it up to 1 pt strokes and 9

pt type to be safe.

Outline every font

Even with the right font installed at our end,

font substitution glitches happen. Outlining

converts type into vector paths — what you

see is exactly what we get.

1. Select all your text (⌘A, on the Artwork

layer)

2. Type > Create Outlines (⌘⇧O)

3. Save

Save a copy first. Once outlined, text is

no longer editable. Keep a working

version with live type so you can fix typos

without redrawing from scratch.

A note on small caps & condensed

Both push readability lower. If you're using

either, give yourself a bit more headroom — 9

pt minimum instead of 8.

EYE-TEST  Print your label at 100% on plain office paper before sending. If you can't read the

ingredients list at arm's length, neither can your customer.

brimlabel 09 · FONTS & LINES
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10 EAN BARCODES & QR CODES

Test it before you send it.
An unscannable barcode is a label that fails at the checkout.

Run your phone's camera over it before you send the file — if

your phone can read it, the supermarket scanner can.

Three rules

CONTRAST Black on white reads best. Other

colours work but reduce contrast —

test first.

FORMAT Vector is ideal — scales without

losing edge crispness. 300 dpi

PNG/TIF works if you can't go

vector.

SIZE Don't scale EAN barcodes below

80% of the official size, or above

200%.

Quiet zone

Every barcode needs a small clear margin

around it — typically 2 mm on the left and

right of an EAN code. Don't crop into it. Don't

run art into it.

Transparent labels: always put a white

background under the barcode (see page

07). Scanners need contrast against a

known background — see-through

doesn't count.

QR codes

Same rules apply. Use the highest error-

correction level you can afford to fit in the

space — H-level survives a coffee ring; L-level

gives up at a smudge.

5 901234 123457

QR code · vector

Highest error-correction level

you can fit. Test by scanning.

FIG. 10 —

Scannable

codes

Black on white ·

vector preferred

brimlabel 10 · BARCODES & QR CODES
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11 FINAL CHECKLIST

One last look
before you export.
Ten minutes with this list saves you a round of email and gets

your job onto the press the same day. Tick them in order.

EXPORT

Adobe PDF Preset: Illustrator Default — modify compatibility to Acrobat 5 (PDF 1.4). See

the next page for the full setting.

SEND IT THROUGH  Upload via the portal at brimlabel.com/orders or reply to your quote

email with the file attached. Anything under 25 MB sends fine; for bigger files we'll send a

WeTransfer link.

brimlabel 11 · FINAL CHECKLIST

Dimensions — artwork matches the

size we quoted

Bleed — 3 mm on every edge

Safety zone — nothing important

within 1.5 mm of the cut

Layers — named exactly: Diecut,

Varnish, Foil, White, Artwork

Layer order — Diecut top, Artwork

bottom

Diecut — single closed path, on its own

layer

Colour mode — CMYK (or Pantone C)

only; no RGB

Black — solid black is K100, not rich

black

HPI-White — set as Spot, C30 M0 Y0

K0 (if used)

Images — 300 dpi at final size, CMYK,

embedded

Fonts — outlined (working copy saved

separately)

Type & lines — ≥ 8 pt · ≥ 0.5 pt strokes
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12 EXPORTING THE PDF

One PDF. PDF 1.4.
When the file's ready, save out a single PDF using the settings

below. PDF 1.4 (Acrobat 5) keeps layers intact and stays

compatible with every press in our shop.

Save dialog

File > Save As > Format Adobe PDF

PDF preset

PRESET Illustrator Default

COMPATIBILITY Acrobat 5 (PDF 1.4)

PRESERVE Illustrator Editing

Capabilities — off

EMBED THUMBNAILS On

OPTIMIZE FOR WEB Off

Compression tab

Switch to the Compression tab and use these:

COLOR BITMAP Do Not

Downsample ·

ZIP 8-bit

GRAYSCALE BITMAP Do Not

Downsample ·

ZIP 8-bit

MONOCHROME BITMAP Do Not

Downsample ·

CCITT Group 4

COMPRESS TEXT & LINE ART On

No downsampling means the resolution of

your placed images survives the export —

what's at 300 dpi stays at 300 dpi.

// Quick reference — paste-and-go

Preset:        Illustrator Default

Compatibility: Acrobat 5 (PDF 1.4)

// Compression

Color:         Do Not Downsample ·

ZIP 8

Grayscale:     Do Not Downsample ·

ZIP 8

Monochrome:    Do Not Downsample ·

CCITT G4

Compress Text: On

// Marks & bleeds — leave off

Trim marks:    Off

Registration:  Off

Color bars:    Off

Page info:     Off

Bleeds:        Use Document Bleed

NO CROP MARKS  We pull bleed info

straight from the PDF, so you don't need

to add trim marks, registration marks, or

colour bars. They get in the way of our

impositioning.

One file per job. One PDF, all layers, all

variants on separate artboards if you have

a range. Don't zip up a folder of files — it

slows everyone down.

brimlabel 12 · EXPORTING THE PDF
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END TALK TO A HUMAN

That's it. Press time.
Send your file through and we'll be in touch within the working

day. Once you approve the proof, we get it on the press —

typically the same afternoon.

UPLOAD ARTWORK

brimlabel.com / orders

Sign in, drop the PDF, approve the proof,

ship.

QUESTIONS

hello@brimlabel.com

We answer our own emails. Usually within

an hour.

A REMINDER

"Send the file anyway. We'll open it, see what's

missing, and tell you. Most issues take five

minutes to fix once you know what they are."

brimlabel END OF GUIDE

brimlabel
labels as good as what's inside
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